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Welcome

In This Chapter

Welcome to WhatsVirtual 1

Welcome to WhatsVirtual

As an integrated plug-in for WhatsUp Gold, WhatsVirtual provides the capability to discover,
map, monitor, alert and report on both small virtual environments, hosted by a single
VMware host, or entire data centers, managed by one or more VMware vCenter servers.

When you use a vCenter server to manage your virtual environment, it becomes the point of
communication between WhatsVirtual, the virtual machines within that environment, and
the hosts on which the virtual machines are running. WhatsVirtual communicates with the
vCenter server to discover the virtual environment, poll the virtual machines, collect events
associated with actions taken on virtual machines, and issue actions to individual virtual
machines.

The files for WhatsVirtual plug-in are installed automatically with Ipswitch WhatsUp Gold.
Your license file determines whether or not you can access the WhatsVirtual plug-in. To
update your license with a purchased WhatsVirtual plug-in, visit the WhatsUp Customer Portal
(http://www.whatsupgold.com/wugCustPortal).


http://www.whatsupgold.com/wugCustPortal
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Discovering virtual devices

Virtual devices are discovered with physical devices connected to the network during the
WhatsUp Gold discovery process when a VMWare scan is performed. As each device is
discovered, WhatsUp Gold attempts to connect using the VMware vSphere APL. If a
connection is made using the VMware credentials through the VMware vSphere API, the
device is assigned to either the VMware vCenter server, or VMware Host role, and a query is
made through the API to determine which virtual machines are associated with the
managing server.

The VMware scan type enables the discovery of vCenter servers, hosts and virtual machines.
Use the Scan Settings on the Discovery Console, to set the scan type, add VMware vCenter
servers or VMware hosts as targets for the VMware scan, and select the option to rescan
vCenter servers that have already been added to WhatsUp Gold using WhatsVirtual. For more
information, see Scan settings in the Discovery Settings help.

T

i€ Note: If you are managing your virtual environment using a vCenter server and want to
collect detailed hardware information about the VMware hosts within that environment, you
must add and select the credentials for those VMware hosts as well as for the vCenter server.

@ Important: If you do not select the Auto scan virtual environments option in the Discovery
Console Advanced settings prior to performing a VMWare scan, virtual machines associated
with the host that are outside of the scan range are not discovered, and virtual machines
discovered because they are included in the scan range are not automatically associated with
the virtual host.

< Tip: To ensure virtual devices are found during discovery, confirm VMware Tools are installed
on each virtual machine you want to discover. If VMware tools are not installed on a virtual
machine, the device will not be discovered during the VMware Scan.
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While you can add as many targets to the VMware scan as is needed, you can also discover
your virtual environment by selecting the vCenter server that is managing your environment
as the target of the scan. This will result in the discovery of all of the virtual machines and
hosts managed by the vCenter server.

For information on the WhatsUp Gold Discovery Console and instructions for discovering
network devices, see Discovering Network Devices and Configuring and Running Discovery in
the Ipswitch WhatsUp Gold help.

If desired, you can specify the default configuration behaviors of virtual devices found during
the WhatsUp Gold discovery by using the Device Role Settings dialog which is accessed
through the WhatsUp Gold console. The Device Role Settings determines which monitors,
context menu items, and custom web links are assigned to the wireless device, as well as
defining which wireless device attributes are collected during polling.

To modify Device Role Settings:

1 Access the Device Role Settings dialog, select Tools > Discover Devices from the
WhatsUp Gold console main menu. The WhatsUp Gold Discover Devices dialog appears.

2 From the Discover Devices dialog menu, select Advanced > Device role settings. The
Device Role Settings dialog appears.

Device Role Settings =] B3
Device Role Settings
e

This dialog allows you to specify the default configuration behavior of the WhatsUp discovery, how a device is going to be configured after its
role has been identified.
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3 For virtual devices, configure the following device roles:
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=  VMware Host

'LTT Note:: Devices cannot be manually entered into WhatsUp Gold, they are automatically added
during discovery. For more information on discovery options, see Configuring and running
discovery.

Viewing discovery output

The Device View provides a hierarchical scheme for display and monitoring of the virtual
environment. The following logical groupings are automatically created based on
information gathered during a VMware scan:

* VmwareScan. A logical container that contains all of the Datacenters, virtual hosts,
and virtual machines discovered during a VMware scan.

* Datacenter. A logical container that contains all of the virtual machines managed by
a vCenter server and the virtual hosts providing managed resources as reported to
WhatsVirtual during a VMware scan.

'LTT Note: While a vCenter server may manage one or more datacenters, virtual machines cannot
be moved using VMotion to a host outside of the datacenter of its original host.

* Cluster. A logical container that contains a group of hosts that share resources and
enable the VMware Distributed Resource Scheduler (DRS) and VMware High
Availability (HA) solutions. A cluster lists the VMware hosts and virtual machines as
reported to WhatsVirtual during a VMware scan.

=8 J VmwareScan (5/21/2010 2:42:27 [

--J Yhdware Cluster: Atl-Clusterl
{4 YMware Cluster: QA fake clus
(3 VMware Datacenter: Atlanta

D Yhdware Datacenter: QA Test

A VMware Servers dynamic group identifies all VMware servers discovered during the
discovery scan.

» 7] Frequently polled Performant
----- /] Printers
----- 1”1 Unacknowledged Devices

2] Ve Server]

L] Windows Devices
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Discovered vCenter servers, virtual hosts and virtual machines can be viewed on the Map
View. Select the Cluster or Datacenter you want to view from the Device Groups pane, then
select the Map View. The selected vCenter, virtual hosts and all of the managed virtual
machines appear on the Map View.

Bt
172.16.42 | b= 8
I A[EF &
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VWin7_32bit-1

WVWIN2008-1

I |
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vwin2003-1

ywin2008-2 ipswitch_m.ipswitch.com

Manage and monitor virtual devices

Using WhatsVirtual, WhatsUp Gold manages virtual devices similarly to physical devices; you
can add performance monitors, active monitors, and passive monitors; set thresholds in the
Alert Center and create alerts associated with these thresholds; create customized actions
and create action policies that invoke these actions; and collect and view events created by
the vCenter server in response to actions taken in support of vMotion, High Availability (HA)
and virtual machine security.

While much of the management and monitoring of virtual devices is the same as physical
devices, areas where there are differences include:

* Performance monitor data gathering methods for virtual hosts.

* Extended right-click menu options for virtual machines.

» vCenter server event collection in support of vMotion, High Availability (HA) and
virtual machine security.

=  Manual addition and classification of virtual hosts and virtual machines.

Performance monitors

Performance monitors are automatically assigned after discovery based on role. Additionally,
you can assign performance monitors manually from the Performance Monitors tab of the
Device Properties menu. vCenter servers and their managed virtual machines use the
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VMware vSphere API to gather statistics for the CPU, Memory, Disk, and Interface Utilization
performance monitors.

Actions on virtual machines

You can create actions to be applied to virtual machines from the New VMware Action dialog
(Configure > Action Library > New > VMware). You can power on, power off, suspend,
reset, shutdown a guest, restart a guest, or take a snapshot of the virtual machine.
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From the web interface, you can immediately run an action on a virtual machine from the
Map View by clicking on the virtual machine, selecting the action you want to perform from
the list in the device information window that appears, and clicking Submit.

Vs
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\ Disk (Read/Write): 0 bps/0bps
Interface (Tx/Rx): 0 bps /4000 bps
<4 .
Vi oA WinZkE_R2_64_Oraclelly
i
CA Wista B4

vCenter server event collection

WhatsVirtual uses the VMware vSphere API to collect events from the vCenter server about
your virtual environment. These events are generated by the vCenter server in support of
VMware technologies such as VMotion, Distributed Resource Scheduler (DRS), High

Availability (HA) and Fault Tolerance.

You can configure WhatsVirtual and WhatsUp Gold to collect events of interest from the
vCenter. There are several groups of events that can be selected. By using thresholds in the
Alert Center or actions defined in the Action Library, these event groups can then be used to
trigger actions and alerts, as well as provide information to reports about your virtual

environment.

The process for configuring WhatsUp Gold to collect, alert, and perform actions on events

includes the following tasks:

* Enable event collection (Global setting to enable event collection)

»  Configure event groups and start event collection for individual vCenters.

You enable the collection of events from the WhatsUp Gold console (Configure > Program
Options > General). The Enable WhatsVirtual event collection option is selected by
default. Thisis a global option that allows the collection of events from all of the vCenter

servers WhatsUp Gold discovers.
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After WhatsUp Gold has been enabled to collect events, each vCenter server must be
configured to collect the events you wish to collect. The event collection configuration of a
vCenter server is accomplished from the Configure VMware event listener dialog. To reach
the Configure VMware event listener dialog, click Configure event collection on the Device
Properties - Virtualization dialog.
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Use the Configure VMware event listener dialog to:

= Control the collection of events from the vCenter server.

= Select the predefined event groups that contain the events you want to collect.
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= Selecta custom list of events from the Other events dialog.

& Configure VMware event listener

Event collection is ON for this vCenter server. Stop collecting

@ When collecting events from a vCenter server, you can:

= Consult reperts to browse and search for events.

Select events you want to collect:

All HA (High Availability) error events (6 event types)
All Virtual machine migration events (11 event types)

[C] Al security related events (2 event types)

Other events  (advanced - 0 event types)

» Alert on certain events from the WhatsUp Gold Alert Center,

K
Cancel

Help
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Select the predefined groups of events you want to collect. To see the events included in
each group, click the <#> event types link beside the group. For more information about the
event types, see Configure VMware event listener in the dialog help.

Event collection is OM for this vCenter server. Stop collecting

= Alert on certain events from the WhatsUp Gold Alert Center.
= Consult reports to browse and search for events.

@ When collecting events from a vCenter server, you can:

Select events you want to collect:

All HA (High Availability) error events (6 event types)

= Das Agent Unavailable

= Das Host Failed

= Insufficient Failowver Resources

= Host Das Errer

= Mot Encugh Resources To Start Vm
» ¥Ym Das Update Error

All Virtual machine migration events (11 event types)
[C] All security related events (2 event types)

Other events  (advanced - 0 event types)

10
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To select from the other events list, click on the advanced - <#> event types link. The Other

events dialog will open. This window is a hierarchical tree of the available events. Selecting
the root of any tree, selects all of the events associated with that event group. To open an

event group, clickthe ' icon.

Select events you want to collect:

o | All HA f“lg" Avalabs |r-;] error events (B event types)

| All Virtual machine migration events (11 event types)

All secunty related events £ event types)
Other evenis  (advanced - 0 event types)

Template Upgrade
Resource Pool
Cluster

License Expired
LICENSe

Task

Datastore
Authorization
Custom Field
Alarm
Scheduled Task
Vm

Haost

Upgrade
Session

General

oK

Cancel

Helg

You can select any of the event types from the Virtualization Events type box. The threshold

will alert when any event within that event type occurs during the threshold period.

11
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Configuring a VMware threshold from the Alert Center

You can create a VMware event threshold in the WhatsUp Gold Alert Center on any event
group WhatsVirtual is configured to collect from the managing vCenter server. Use the New
VMware Threshold dialog to configure the alert threshold. (Alert Center Tab > Threshold
Library > New > VMware)

& New VMware Threshold [ Sl
MName
Virtualization Events type i
All HA (High Awailability) error events -

Threshold

@ The threshold will alent immediately if an event occurred
within the last Threshold Check of 1 minutes

The threshold will alert when:

(Ceeas

Motification

(Mo policy) -

Threshold Check DK

1 i
Check threshold every minutes Cancel

Manually assigning a VMware server role to a device

You can manually designate discovered devices as vCenter servers or virtual hosts on the
Device Properties - Virtualization dialog.

() This device is not a YMware server
() This device is @ YWMware host

@) This device is a VMware vCenter server

To manually designate a device as a vCenter server or virtual host, you must select or create
VMware credentials for the device, and then select the VMware server role you want to assign
to the device.

* Select This device is a VMware host, if you want to designate the device asa
VMware host.

12
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» Select This device is a VMware vCenter server, if you want to designate the device
as a vCenter server.

After a device is designated as a vCenter server or VMware host, you can manually associate
virtual machines by clicking the Add button on the Virtualization tab of the Device
Properties dialog. WhatsUp Gold polls the vCenter server or VMware host to discover all of
the virtual machines it is managing, and displays a list of these machines on the Associate
WUG device to a virtual machine dialog.

& Associate WUG device to a virtual machine Lﬁ

Device to be established as a virtual machine:

<select a device = E]

Free virtual machines hosted on the VMware server:

ATL-5offTest -
damn small linux
FlowSensorVE3

Google Chrome
ISCSI-5torage

MNetBSD5

Mostalgia

Taggart

TEST-esxil

TEST-esxid
TEST-SharedStorage
Ubuntu Server 9.04 32-hit
VA-ntop

VA-ntop2 oK
vmMetBsD5 _—
YMware Studio Cancel
vmWinXP-Progghit e ——
WinXP_1_Test <[ Heb |

m

You can also use the Browse (...) button to locate the device you want to add as a virtual
machine.

r Note: Devices that are manually designated as a vCenter server, VMware host, or virtual
device respond to actions created for virtual environments, and appear as virtual devices in
dashboard reports, however they do not appear on the Map View as virtual devices until
they are discovered using a VMware scan.

Viewing the WhatsVirtual maps

After you have completed your VMware discovery scan, you may view your virtual devices in
either the WhatsUp Gold console or the WhatsUp Gold web interface. The WhatsVirtual maps
are rendered from the information gathered from the vCenter server and show all reported
connections between virtual machines, VMware hosts, DataCenters, and the vCenter server.
Maps are generated specifically for each Cluster, DataCenter, VMware host, and vCenter
server discovered during the VMware scan. Click View > Refresh in the console to update the

13
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WhatsVirtual maps, so that changes to the virtual environment are reflected in the maps, such
as when virtual machines are powered off, migrated, or deleted. You can configure the
WhatsVirtual maps to only show virtual machines that are powered on, and you can set the
interval which WhatsVirtual will collect mapping data.

To view a WhatsVirtual map in the WhatsUp Gold console interface:
1 Click on the Whats Virtual tab in the WhatsUp Gold views dialog.

_or_.

In the navigation pane of the WhatsUp Gold views dialog, click WhatsVirtual. The
WhatsVirtual navigation pane appears.

v Device View I S Map Wiew I 2k Whats Uirtualr

2 Expand the VMware maps tree and select the map you want to view.

To view a WhatsVirtual map in the WhatsUp Gold web interface:
1 Select Virtual in the ribbon header.

Dashboard Devices Reports Logs Inventory Flow Monitor  Alert Center  Wireless  Virtual Configured  Other Plugins  Admin  AlertFox

WhatsVirtual | Map | Eventlog

2 Expand the VMware maps tree and select the map you want to view.

W Note:: The WhatsVirtual map view in the web interface is a "live map" meaning the map
refreshes a the data collection interval and devices may move, disappear, or appear based
on their association with the server.

3 Use the slider bar to zoom in or zoom out of the WhatsVirtual map. You may also pan
left, right, up, or down by clicking on the map and moving the direction you would like
to go.

C Tip:You can start, stop, or reset a virtual machine from using the WhatsVirtual web interface
right-clicking on a virtual machine displayed in the map and selecting Power On, Power Off,
or Reset.

Configuring WhatsVirtual Live Maps

You may configure WhatsVirtual live maps in either the web interface or console.

14
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Configuring live maps in the web interface

From the preferences dialog which is located in the WhatsVirtual navigation pane, you can
set the data collection interval (vCenter polling interval for each device), configure the maps
to show only those virtual machines that are currently powered on, and manually refresh
WhatsVirtual maps.

Preferences

¥ Only show powered on virtual machines,

Mapping data collection interval: 5 min,

Refresh

To set the data collection interval for WhatsVirtual maps, move the slider to the right to
increase the collection interval, or move the slider to the left to decrease the collection
interval.

@ Important: The default data collection interval is 5 minutes. Settings lower than the default
may create a higher than normal CPU usage (up to an additional 20% of available CPU) on
the WhatsUp Gold server and may increase overhead on the vCenter server.

Select the Only show powered on virtual machines check box to show only virtual
machines that are powered on.

Click Refresh to refresh the WhatsVirtual maps. The maps will refresh with information
gathered during the latest poll of the vCenter server.

Configuring live maps in the console interface

From the map data collection configuration dialog which is located in the WhatsVirtual
navigation pane, you can set the data collection interval (vCenter polling interval for each
device), configure the maps to show only those virtual machines that are currently powered
on, and manually refresh WhatsVirtual maps.

[ Only show powered on virtual machines.

Mapping data collection interval: 5 min.

[
|

Refresh

% Configure map data collection

15
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To set the data collection interval for WhatsVirtual maps:

1 Inthe WhatsVirtual navigation pane, click Configure map data collection. The
WhatsVirtual map configuration dialog appears.

2 Move the slider to the right to increase the collection interval, or move the slider to the
left to decrease the collection interval.

@ Important: The default data collection interval is 5 minutes. Settings lower than the default
may create a higher than normal CPU usage (up to an additional 20% of available CPU) on
the WhatsUp Gold server and may increase overhead on the vCenter server.

To show only virtual machines that are powered on:

1 Inthe WhatsVirtual navigation pane, click Configure map data collection. The
WhatsVirtual map configuration dialog appears.

2 Select the Only show powered on virtual machines check box.
To refresh the WhatsVirtual maps:

Click Refresh to refresh the WhatsVirtual maps. The maps refresh with information gathered
during the latest poll of the vCenter server.

Managing virtual machines using WhatsVirtual live maps

Clicking on an icon within the WhatsVirtual live map launches a dialog that displays detailed
information about the individual virtual machine. The following information is displayed:
* Power State. Indicates if the virtual machine is powered on or off.

* VMware Tools Status. Indicates whether or not VMware Tools is running on the
virtual machine.

* IP Address. Displays the IP address currently assigned to the virtual machine.

= Operating System. Displays the OS currently installed and running on the virtual
machine.

* CPU Load. Displays the current percentage of CPU usage by the virtual machine.

* Memory Load. Displays the current percentage of memory usage by the virtual
machine.

* Disk (Read/Write). Displays the speed data is being read from and written to the
virtual machine's disk.

= Interface (Tx/Rx). Displays the speed data is being sent from and received by the
virtual machine.

T Note: If VMware Tools are not installed, IP Address and Operating System will not appear in
the information dialog. If any other virtual machine details are not available, affected boxes
will not appear in the information dialog.

This dialog also allows you to perform certain actions on a machine.

16
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To perform an action on a virtual machine:

1 Click the icon representing the device on the WhatsVirtual live map to launch the
detailed information dialog.

2 Use the Select Action list to choose which action to perform.

Power On.
Power Off.
Suspend.

Reset.

Guest Shutdown.

Guest Restart.

3 Click Submit.

Gl

L

Note: If any virtual machine actions cannot be performed, affected actions will not appear in
the Select Action list.

Viewing the WhatsVirtual reports

Dashboard reports

The following reports have been added to WhatsUp Gold to provide information about your
virtual environment.

TR

L

Virtual Host List. This dashboard report provides a list of all the virtual hosts on the
network.

Virtual Machine Current CPU Utilization. This dashboard report provides the
current CPU utilization for the selected virtual machine.

Virtual Machine Current Disk Utilization. This dashboard report provides the
current Disk utilization for the selected virtual machine.

Virtual Machine Current Interface Utilization. This dashboard report provides the
current Interface utilization for the selected virtual machine.

Virtual Machine Current Memory Utilization. This dashboard report provides the
current Memory utilization for the selected virtual machine.

Virtual Server. This dashboard report provides a list of all the virtual machines
managed by a virtual server. The virtual server may be a vCenter server or VMware
host.

Virtual Server Attributes. This dashboard report provides system attributes for the
virtual server, hardware information for VMware hosts, and a list of the virtual devices
managed by the virtual server. The virtual server may be a vCenter server or a VMware
host.

Note: Hardware information will be displayed only if the selected device is a VMware host for
which credentials were supplied and selected during a VMware scan.

17
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* WhatsVirtual Events. This dashboard report displays events that WhatsVirtual is
configured to collect from the vCenter server. The events appear in reverse
chronological order, so that the last event received appears at the top of the list.

Configuring VMware dashboard reports

Before you can configure a dashboard report, it must be added to your dashboard view. For
information on adding dashboard reports to a dashboard view, see Adding dashboard
reports to a dashboard view in the dialog help.

Configure VMware dashboard reports on the Configure Report dialog (Menu > Configure
Report).

Click the Browse (...) button to select the device you want to use as a data source for the
report.

Full reports

WhatsVirtual Events. This report displays events that WhatsVirtual is configured to collect
from the vCenter server. The events appear in reverse chronological order, so that the last
event received appears at the top of the list.

You can access the WhatsVirtual Events report from the WhatsUp Gold web interface by
selecting Event Log from the Virtual tab.

About the WhatsVirtual Event Log

The WhatsVirtual Event Log provides a record of the events generated by virtual devices
managed by a vCenter server.

To access the WhatsVirtual Event Log:
*  From the WhatsUp Gold ribbon, click Virtual > Event Log.

WhatsVirtual

Date ranger | Custon v | Fromi | drifdie 7| | 118 PM @ Tor | dridcon | | 3y Pwi © G Page sz | 500 v PFrini/Expori™

- EvantType Clear Filters

Diate Diewica T DataCerter T Hoit T irtusMachind® | Lser T EvarkType T Menage
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T

| Note: To gather events for this report, make sure you have enabled WhatsVirtual event
collection. From the WhatsUp Gold console, click Configure > Program Options, click
General, then select the Enable WhatsVirtual event collection check box. For more
information, see WhatsUp Gold Program Options.

L

To configure the types of events gathered for WhatsVirtual Event Log:
Click Devices > Devices from the WhatsUp Gold navigation ribbon.

Locate the vCenter server in the device list.

Right-click on the vCenter server and select Properties.

Click Virtualization in the Device Properties dialog that appears.

Select This device is a VMware vCenter server if it is not selected already.
Click Virtualization Events.

Use the Configure VMware Event Listener dialog to select event types you want to
collectin the WhatsVirtual Event Log.

NOWUu bHhWN=

For more detailed information on applicable device properties and VMware event types, see
Using Device Properties - Virtualization and Configure VMware event listener.

Log Body
The following information is displayed in the log:

* Date. Displays the date and time the event occurred.

* Device. Displays the name, alias, or IP address of the device on which the event
occurred.

= DataCenter. Displays the name of the data center if event is specific to a data center.
* Host. Displays the name of the host if event is specific to a host.

* VirtualMachine. Displays the name of the virtual machine if event is specific to a
virtual machine.

* User. Displays the VMWare user associated with the event.

| Note: Many events are the result of automatic actions within the VMware system. The user
box will only display a VMware user when the event is the result of user action.

» EventType. Describes the event that occurred.
* Message. Displays the message sent from the vCenter server to WhatsVirtual.

TP
' Note: If the log data exceeds the maximum number of records set for full reports, use the

Paging Options to view more records for the report. The maximum number of records any
full report displays is specified in the Preferences dialog.

L

Event Log Customization

You can use the preset date ranges or specify a custom range using the date and time
controls at the top of the Event Log page. After selecting the desired date and time, click Go.

19
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The event log report only displays event data that occurred within your specified range.
Additionally, you can click and drag the column headers to group the Event Log data by one
or more columns. To remove grouping for a column, click X to the right of the column for
which you want to remove column grouping. You can also view Event Log column data
according to user-defined filters.

To create a custom filter for a column:
1 Clickthe T icon for the column you want to filter.
2 Use the dialog that appears to define the filter.

3 Click Filter to apply the filter to the column.

I’"_ Note: Multiple columns can have filters applied simultaneously.

Export Options

To export Event Log report data:
1 Click Print/Export.
2 Select one of the following options:

= PrintView. Displays a printable Event Log report in a new browser window.

= Export to PDF. Launches a Print/Export Options dialog that allows you to select
Current page or All pages. Click Ok to generate a .pdf file of Event Log data applicable
to your selection.

= Exportto CSV.Launches a Print/Export Options dialog that allows you to select
Current page or All pages. Click Ok to generate a .csv file of Event Log data applicable
to your selection.

Copyright notice

©1991-2015 Ipswitch, Inc. All rights reserved.

This document, as well as the software described in it, is furnished under license and may be
used or copied only in accordance with the terms of such license. Except as permitted by
such license, no part of this publication may be reproduced, photocopied, stored on a
retrieval system, or transmitted, in any form or by any means, electronic, mechanical,
recording, or otherwise, without the expressed prior written consent of Ipswitch, Inc.

The content of this document is furnished for informational use only, is subject to change
without notice, and should not be construed as a commitment by Ipswitch, Inc. While every
effort has been made to assure the accuracy of the information contained herein, Ipswitch,
Inc. assumes no responsibility for errors or omissions. Ipswitch, Inc., also assumes no liability
for damages resulting from the use of the information contained in this document.
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